
======================================================================
==
==     Updating the database in your Bendix/King GPS unit using
==     either the Windows-based GPS Database Loader Version 1.2 or
==     the DOS-based NETLOAD.EXE.
==
==     Readme Text File
==
======================================================================

======================================================================
==     Internet Database Updates
======================================================================
You can use either the Windows-based GPS Database Loader program or
the DOS-based NETLOAD.EXE to update the navigation database in your
KLN 90/A/B, KLN 900, KLN 89/B, KLX 135A, KLN 35A, KLX 100, or KLN 94
Bendix/King GPS unit with database updates which have been downloaded
from the www.gpsdatabase.com Internet web site to your computer.

The Windows-based GPS Database Loader is compatible with Windows 95, 
Windows 98, Windows Millennium edition, Windows NT 3.51 / 4.0, 
Windows 2000, Windows XP, (or higher).

The DOS-based NETLOAD.EXE program is compatible with MS-DOS 3.3 (or 
higher).  Microsoft Windows 3.1 users must exit from Windows to DOS 
mode before running the NETLOAD.EXE program.

======================================================================
==     Diskette-based Database Subscriptions
======================================================================
If you have purchased a diskette-based subscription, you will need
to insert the first database diskette into your floppy drive, restart
your computer, and allow the computer to reboot from the diskette.

======================================================================
==     KLX 100 Host Software Updates
======================================================================
You can use either the GPS Database Loader program or X100V202.EXE to
update the host software in a Bendix/King KLX 100 GPS/COMM with host
software updates obtained from the http://www.gpsdatabase.com Internet
web site.  (At the time of this writing, you could access the KLX 100
software files by clicking "Download", then clicking "KLX 100", and
then clicking "Here".)

======================================================================
==     System Requirements 
======================================================================

To run the Windows-based GPS Database Loader, you will need a fully
IBM-compatible computer (33 MHz or faster) with at least 8 MB of RAM
and a VGA or super VGA display (& card) that runs Operating system
Microsoft Windows 95, Windows 98, Windows Millennium edition, 
Windows NT Version 3.51 / 4.0, Windows 2000, Windows XP, (or higher) 
and a mouse or compatible pointing device supported by Microsoft 
Windows.

To run the DOS-based NETLOAD.EXE program, you will need fully 
IBM-compatible computer that runs DOS Version 3.3 (or higher).

In order to use the Windows-based GPS Database Loader program or the 
DOS-based NETLOAD.EXE to update the navigation database in your
Bendix/King GPS unit(s), you must also have:

(1)     A hard disk with approximately 5 MB available.

(2)     An Internet connection (via a network or modem) and a web
        browser (Netscape Navigator, Internet Explorer, etc.) to
        download database updates from the www.gpsdatabase.com web
        site.



(3)     An RS-232 serial communications port (COM1:, COM2:, COM3:,
        or COM4:) available and functioning under Microsoft Windows.
        The RS-232 serial COM port must be capable of communicating
        using 9600 baud, 8 data bits, 1 stop bit, odd parity, and
        Flow control: None.  For best performance, the COM port
        should be able to communicate at 115.2K baud (most do).
        In Windows, if your PC has a USB port (and no COM ports),
        you will need to obtain a USB to Serial Adapter to convert
        your USB port to a serial port.  For more information see
        "Installing a USB to Serial Adapter" in the GPS Database 
        Loader's On-Line Help by selecting "Help" -> Help Topics 
        -> Setting Up -> "Installing a USB to Serial Adapter".

(4)     A PC interface cable that connects between your GPS unit's
        data loader jack and your personal computer.  Depending on
        the type of unit being updated, the cable may be an optional
        item or it may be included in the original install kit.
        An interface cable can be obtained by ordering the appropriate
        PC Data Loader Kit for your GPS unit from the table below:

        GPS Unit Type           PC Data Loader Kit Part Number
        -------------------     ------------------------------
        KLN 90/A/B, KLN 900     050-03213-0000
        KLN 89/B, KLX 135A      050-03213-0000
        KLN 35A                 050-03213-0000
        KLX 100                 050-03376-0000
        KLN 94                  050-03612-0000

        To order a PC Data Loader Kit, contact Honeywell
        Wingman Services as follows:
                Honeywell Wingman Services
                Tel:  (800) 247-0230 (U.S. Callers)
                Tel:  (913) 712-3145 (International)
                FAX:  (913) 712-3904.
                Email:  nav.database@honeywell.com
                Web site:  www.gpsdatabase.com

(5)     A power supply for your GPS unit.  This power supply may
        take the form of the aircraft or an outside source (if the
        GPS unit is removed from the aircraft).  If the GPS unit
        is to be used away from the aircraft, Honeywell 
        recommends one of the following Commander units built by
        Lone Star Aviation Corporation, 804 North Great S. W. Pkwy,
        Arlington, TX  76011,  Phone: (817) 548-7768,   FAX: 
        (817) 633-6208. (Contact Lone Star and ask for a brochure).

        LoneStar Unit:  Commander 2000-K Desktop Control Station
                (12 volt power supply, cooling fan connection,
                RS-232 connector, external OBS LEG switch)
                Compatible with:  KLN 90/A/B, KLN 89/B, KLN 94, 
                                  KLX 135A, and KLN 35A

        LoneStar Unit:  Commander 2900-K Desktop Control Station
                (24 volt power supply, RS-232 connector, DZUS mount)
                Compatible with:  KLN 900

======================================================================
==     Installing and starting the Windows-based GPS Database Loader
======================================================================
The GPS Database Loader must be installed on your computer's hard
drive before it can be used.  To install the GPS Database Loader,
perform the following steps:

(1)     Start your computer and start your version of Microsoft 
        Windows 95, Windows 98, Windows Millennium Edition, Windows
        NT Version 3.51 / 4.0, Windows 2000, Windows XP, (or higher).

(2)     Start your web browser (Netscape Navigator, Internet
        Explorer, etc.) and go to the www.gpsdatabase.com web site.
        Then, from the "Download" tab choose "Windows utility".
        Then, click on the "Click here" link and save the Setup12.exe



        file to your hard disk.  Be sure to remember the directory
        that you downloaded it to.  (For example c:\temp)

(3)     Select Run from the Windows Start button, and run the self-
        extracting SETUP12.EXE program from the directory that you
        downloaded it to.  (For example c:\temp\Setup12.exe)  This
        program will extract, uncompress, and install the software.

(4)     Click on the "Setup" button, and then follow the instructions
        as they are presented to you on the screen to install the
        GPS Database Loader.

(5)     Once you have installed the GPS Database Loader onto your
        computer, you can start the GPS Database Loader program by
        selecting:  Start -> Programs -> GPS Database Loader.

(6)     Once the program is running, you can press "F1" or select
        "Help Topics" from the "Help" menu if you need help running
        the program.

Note:   The GPS Database Loader program can be uninstalled by
        simply selecting: Start --> Settings --> Control Panel
        --> Add/Remove Programs --> GPS Database Loader.

======================================================================
==     Starting and Using the DOS-based NETLOAD.EXE program
======================================================================

Here are the instructions for using the DOS-based NETLOAD.EXE program
to update the database in your Bendix/King GPS unit:

(1)     If you have not done so already, you must download a
        DATABASE.EXE file from the www.gpsdatabase.com web site.
        Complete, up-to-date information about obtaining database
        updates is available on the Internet at www.gpsdatabase.com.

(2)     Use the PC Data Loader Cable to connect your PC's serial
        COM port to your GPS unit's data loader jack.

(3)     From "pure" DOS mode please do the following:
        (*** Note:  Please see all five notes below) 

(4)     CD ..   (press Enter)    <---  (Change directory to the main 
        directory)

(5)     DIR/W   (press Enter)     <---  (Display a list of files in
        the main directory)

(6)     CD DATABASE    (press Enter)   <---  (Change to the directory
        where you stored the downloaded DATABASE.EXE file.)

(7)     DATABASE -o    (press Enter)    *Note:  The "-o" means "Overwrite".

(8)     Then, in the directory with NETLOAD.EXE and DATABASE.DAT, 
        type NETLOAD at the DOS prompt.  

        NETLOAD     (press Enter)

(9)     Make sure that the database verifies correctly, then press
        ENTER to return to the menu.

(10)    The NETLOAD software is initially configured to use the COM
        Port 1.  If you want to use a different COM port, you will
        need to choose option 4 from the PC menu to select a different
        COM port.

(11)    Choose option 1 ("Upload Database to Host Unit") from the menu
        on the PC to upload the database to your GPS unit.

(12)    On your GPS unit, go to the database update page.  Press ENT
        on your GPS unit to begin the database update.  If your GPS
        unit asks you to APPROVE the estimated load time, press ENT



        again.

(13)    If communication is not established between the GPS unit and
        the PC, the first thing to check is the cable connection.  If
        it is secure, try a new COM port (option 4 from the PC menu).

***     Note 1:  To run NETLOAD on a computer running Windows 95 or 
          98, you must select Start -> Shutdown -> "Restart in DOS 
          mode" before running NETLOAD.

***     Note 2:  To run the DOS-based NETLOAD.EXE on a Windows NT 
          machine, you must first reboot your computer using a DOS 
          system diskette.

***     Note 3:  If you are using Windows 98 or Windows Millennium 
          Edition, you may be able to run NETLOAD from a MS-DOS
          Window by simply setting the "Idle sensitivity" to "Low" 
          on the "Misc" tab of the MS-DOS window properties.

***     Note 4:  The only way to restart the computer in DOS mode 
          from a computer running Windows Millennium Edition is to 
          restart the computer using either a DOS system disk or a
          WindowsME Startup Disk in drive A.

        To create a WindowsME startup disk:
          (1) Select  Start -> Settings -> Control Panel.
          (2) Double-click on "Add/Remove Programs"
          (3) Click on the "Startup Disk" tab
          (4) Click on the "Create Disk..." button
          (5) Then follow the instructions ....

        After your WindowsME Startup Disk is created, put the 
        startup disk in drive A: and select Start -> "Shut Down..." 
        and then select "Restart" from the pull down menu and press OK.

***     Note 5:  The DOS-based NETLOAD.EXE program will only work 
          with actual COM serial ports.  The DOS-based NETLOAD.EXE 
          program will NOT work with a USB port that has been 
          converted to a serial port with a USB to serial adapter 
          even if you enable "DOS box" support. 

======================================================================
==     Obtaining Database Updates for your GPS unit
======================================================================

Complete, up-to-date information about obtaining database updates for
Bendix/King GPS Products is available on the Internet at:  
http://www.gpsdatabase.com.

The www.gpsdatabase.com web site contains the following information:

(1)     Instructions for how to purchase and download the current
        database for your Bendix/King GPS unit using the Internet.

(2)     Instructions for how to order the current database through
        the mail using either the cartridge or diskette options.

(3)     Current database prices, file sizes, and area coverages.

(4)     Information about database expiration dates, available and
        effective dates for all databases.

(5)     Information about PC system requirements, cable information,
        and troubleshooting.

If you wish to call us to set up an account or if you need further 
information, you can reach us at:

        Bendix/King Wingman Services
        Customer Service
        Tel: (800) 247-0230 (U.S. Callers)
        Tel: (913) 712-3145 (International)



        FAX: (913) 712-3904.
        email: nav.database@honeywell.com

All owners of factory new units are eligible for a database update
within the FIRST 45 DAYS AFTER INSTALLATION (the serial number of the
unit is required).  Subsequent updates are available for purchase.

Database updates are current for 28 days after the effective date
shown on the www.gpsdatabase.com web site.  If you select any service
other than the complete 13-time service, your unit will alert you
after 28 days when your database is expired.

======================================================================
==     Database Update Service Order Form
======================================================================

As shown below, Bendix/King offers several update service options to
suit your requirements.  If you wish to mail or fax us your order,
simply print the following order form

Then, write your information on the printed form and mail (or FAX) us
the completed order form.  Credit card orders may be faxed.

Check Desired Database Update Service:

GPS Unit    Region      Select Type of Update Service Desired

KLN 90/A/B      Americas    ___ Internet,   ___ Diskette
                        ___900 Card,    ___ 90B cartridge

KLN 900     Atlantic    ___ Internet,   ___ Diskette

            Pacific     ___ Internet,   ___ Diskette

KLN 89/B    Americas    ___ Internet,   ___ Diskette,   ___ Card
            Atlantic    ___ Internet,   ___ Diskette
            Pacific     ___ Internet,   ___ Diskette

KLX 135     International    ___ Diskette
            North America    ___ Diskette

KLN 35A     Americas    ___ Internet,   ___ Diskette

KLX 135A    Atlantic    ___ Internet,   ___ Diskette
            Pacific     ___ Internet,   ___ Diskette

KLX 100     Americas    ___ Internet,   ___ Diskette
            Atlantic    ___ Internet,   ___ Diskette
            Pacific     ___ Internet,   ___ Diskette

KLN 94      Americas    ___ Internet,   ___ Diskette,   ___ Card
            Atlantic    ___ Internet,   ___ Diskette 
            Pacific     ___ Internet,   ___ Diskette

1)  A Windows-compatible PC and a PC Data Loader Cable are required
    for diskette and Internet updates.

2)  Internet users will usually save approximately 20-35% over
    diskette and cartridge prices.

3)  Cartridges (or cards) are available in U.S. and Canada only.

Please select desired type of service (Please check ONE):

(____)  Complete Update Service.
        Provides 13 updates - one every 28 days for one year.

(____)  Six-time Update Service.
        Provides six updates - one every 56 days for one year.

(____)  Four-time Update Service.



        Provides four updates - one during each quarter for one year.

(____)  Single Update.  Provides one update upon receipt of order.

Note:  Updates are current for 28 days after effective date on
  diskette.  If you select any service other than the complete 13-time
  service, your GPS unit will begin alerting you after 28 days that
  your database is out-of-date.

Please set up the service under:

Name:    ____________________________________
Company: ____________________________________
Address: ____________________________________
City:    ____________________________________
State:   ____________   Zip Code: ___________
Country: ____________________________________
Telephone:  (______) _____________________
FAX:        (______) _____________________
E-mail:  ____________________________________
Aircraft Make:  _____________________________
Aircraft Model: _____________________________

Method of Payment   (Please check ONE)

(____)  Check/Money order enclosed

(____)  Wire Transfer:
        Chase Manhattan Bank, NY
        Acct #910-2-538734
        Customer Number: __________________________
        Please contact us if you do not have a customer number.
        (Note:  Your customer number is the first six digits of your
        sales order number.)

(____)  Credit Card
        Card Type:  ___MasterCard,  ___VISA,  ___Discover,  ___Am Expr
        Number:    _______________________________
        Expires:   _______________________________
        Signature: _______________________________

(Include applicable sales tax for your state.)

Please Mail or FAX this Form to:
   Honeywell International Inc.
   Bendix/King Wingman Services, Mail Drop #66
   23500 West 105th Street
   Olathe, KS  66061
   U.S.A.
   FAX:  (913) 712-3904

======================================================================
Connecting a Bendix/King GPS Unit to your PC with the Interface Cable
======================================================================

In order to update the database in your Bendix/King GPS unit, you will
need to connect your Bendix/King GPS unit to an available RS-232 COM
port on your personal computer using an appropriate PC Data Loader
Cable.  To install the PC Data Loader Cable:

(1)     You will need to first place your Bendix/King GPS unit and 
        personal computer physically close together so the interface 
        cable may reach both pieces of hardware.

(2)     Plug the 9-pin female connector end of the interface cable into
        a COM serial port of the computer.  If the computer has COM 1
        and COM 2 serial ports, either may be used.  Some computers use
        a 9-pin COM serial port connector while other computers use a
        25-pin connector.  If the computer being used has a 9-pin
        connector, the interface cable connector will plug directly
        into the computer's 9-pin connector.  If the computer's COM
        serial port uses a 25-pin connector, you will need to use a



        25-pin to 9-pin adapter to adapt the interface cable's connector
        to the computer's connector.  If your PC has a USB port (and no
        COM ports), you will need to obtain a USB to Serial Adapter to
        convert your USB port to a serial port.

(3a)    If you have a KLN 900 or a KLN 94...
        Then, plug the other end of the interface cable into the data
        loader jack that is on the front of your Bendix/King GPS unit.
        You want to make sure to firmly push the jack into the unit to
        ensure that it is completely inserted.

(3b)    If you have a KLN 90/A/B, KLN 89/B, KLX 135A, or a KLN 35A...
        These units require an RS-232 port to be installed in the panel
        of your aircraft.  If you are using the PC interface kit in the
        cockpit, plug the other end of the interface cable into the data
        loader jack that is mounted in the aircraft panel.

(3c)    If you have a KLX 100...
        Then, plug the other end of the interface cable into the
        "RS 232" data port on the right side of the KLX 100.

The interface cable is now ready to update the database or software in
a Bendix/King GPS unit using a PC.

======================================================================
==     Updating the Navigation Database in Your GPS Unit
======================================================================

You can use the Windows-based GPS Database Loader program to
update the navigation database in your KLN 90/A/B, KLN 900, 
KLN 89/B, KLX 135A, KLN 35A, KLX 100, or KLN 94 Bendix/King 
GPS unit with database updates which have been downloaded from 
the www.gpsdatabase.com Internet web site to your computer.

For COMPLETE instructions on using the windows-based GPS
Database Loader, start the GPS Database Loader program by 
selecting: Start -> Programs -> GPS Database Loader.
Then select "Help" from the menu, then select "Help Topics".
Then select any of the following topics for more information.

Getting Started
        Introduction 
        System Requirements 
        Install / Uninstall Questions

Ordering Supplies
        Obtaining Database Updates for your GPS Unit 
        Ordering the PC Data Loader Cable 

Setting Up
        Connecting your Bendix/King GPS Unit to your PC with the
                Interface Cable 
        Selecting Your COM Port 
        Installing a USB to Serial Adapter 

Updating Your GPS unit
        Updating the Navigation Database in Your GPS Unit Using your PC
        Updating the Software in a KLX 100 GPS/COMM
        Updating a KLN 94 Database Card 
        Using the DOS-based NETLOAD.EXE program

Helpful Utilities
        Verifying the Checksums on a Database File 
        Backing up a database file to diskettes 
        Restoring a database file from diskettes 
        Printing a Certificate of Compliance 

        Reading the Database Key from: 
                a GPS Unit 
                a Database File 
                a Card in an ImageMate 
                a Card in a PCMCIA 



Menu Commands
        File Menu
        View Menu
        Update-GPS menu
        Tools Menu
        Options Menu
        Help Menu

Troubleshooting
        Troubleshooting COM Port Problems
        Obtaining Technical Support
        Software License Agreement
        GPS Database Loader Files

======================================================================
==     COM Port Problems
======================================================================

If you are experiencing COM port problems while using NETLOAD, please
see the "Troubleshooting" section below.  If you are experiencing COM 
port problems while using the Windows-based GPS Database Loader,
please refer to the "Troubleshooting COM Port Problems" section of
the GPS Database Loader On-Line Help.  To view this information,
start the GPS Database Loader program by selecting: Start -> Programs 
-> GPS Database Loader.  Then select "Help" from the menu, then select 
"Help Topics".  Then double click on "Helpful Information" and then
select "Troubleshooting COM Port Problems".

Some possible solutions to COM Port problems are as follows:

1.      Have you successfully used the DOS-based NETLOAD program on 
        this computer before?   If so, which COM port did you use?  
        We would recommend trying to troubleshoot using NETLOAD, 
        there are SIGNIFICANTLY fewer variables.  Try using the 
        DOS-based NETLOAD program to update the database in your 
        GPS unit.

2.      Have you EVER successfully updated the database in your GPS?  
        If so, how did you do this?....examples:  (1) via diskettes, 
        (2) using NETLOAD, (3) using the Windows-based GPS Database 
        Loader, (4) using another computer, (5) using a different 
        COM port, etc. 

3.      If you have successfully updated the database in your GPS 
        before, have you installed any new hardware or software 
        since then that might be interfering with the use of your 
        COM ports?

4.      Do you connect to the Internet using a 56K modem and this 
        computer?  Is your Internet software taking control of your
        COM port and not letting other programs have access to your
        COM port.

5.      Do you have another computer that you could use to perform 
        the database updates?

6.      If you are using a USB to Serial Adapter to convert a USB 
        port to a COM port, you must use the Windows-based GPS
        Database Loader to update your GPS, the NETLOAD program will
        NOT work through a USB port.

======================================================================
==     Troubleshooting 
======================================================================

Problems updating your database should be rare, but here are a few
simple items to check in the event of a problem:

Installation / Cabling:  Make sure your interface cable is pressed in
firmly on both the PC's serial port and the data loader jack connected



to the unit.  If the unit always displays "LOADER NOT READY" (on a 
KLX 100 the message will read "COMM CHANNEL TIMEOUT") the cabling and
connections should be checked.

Data Integrity:  The software performs many integrity checks prior to
loading the data into your unit.  Should the data be corrupted for any
reason, you will see a "Checksum error" message on the PC.  In that
event, the data will not upload into your unit, but your old data will
be unaffected.  You may want to download the file again.  (If the next
cycle's data has not yet been posted, you will not be charged again
for downloading the same file.)

Wrong Database Key:  The first thing to do when you see this error is
to make sure that you are loading the same database that you just
downloaded from www.gpsdatabase.com web site.  Did you download the
database to different directory?  The database that you downloaded
will only work with a GPS unit that has a matching key.  Should you
try to upload a database into a unit with a key that is different than
the one you provided for the download, the update will not work.
A database file can only be used to update a single unit.  If you have
accidentally downloaded a database with the wrong database key, please
contact us.  Let us know the correct key and the incorrect key that
you used to download the database.  Credit will be given for honest
mistakes.  After your account has been credited, you will need to
re-download the database from the www.gpsdatabase.com web site.

LOADER NOT READY displayed after previous database erased:  If your 
computer is a laptop (especially common in Compaq Armada laptops), 
you may need to adjust the COM port time-out setting in your 
computer's setup program.  During the time that a GPS unit is 
erasing the previous database (which may take several minutes), 
some laptops will time-out and turn off the COM port to save power, 
causing the database update to fail.  The solution here is to 
increase the time-out period in the computer's setup program.

PC compatibility problems.  The GPS Database Loader and the
NETLOAD.EXE software has been compatible with all IBM type computers
that we have tested.  However, with the multitude of computer brands
available, comprehensive testing is not possible.  If you suspect you
have a PC compatibility problem, please contact Technical Support as
described below.

Macintosh computers:  Although it may be possible to run the GPS
Database Loader or NETLOAD software on a Macintosh computer using
emulator software, we are not currently providing support for the
Macintosh platform at this time.

Invalid database / checksum error:  If your downloaded an invalid
database (or if your database contains a checksum error), you will
need to re-download the database from the www.gpsdatabase.com web
site.  Please note that as long as you download a file for the same
GPS (e.g. KLN 90B), the same region (e.g. Americas), the same
effective date, and the same KEY, you will NOT be charged for
re-downloading the database.

PC/MS-DOS configuration problems with NETLOAD.EXE:  EMM386.EXE and 
QEMM386.SYS have been found to interfere with the NETLOAD software in
some rare cases.  Other DOS device drivers which attempt to control
your serial ports may also interfere with the operation of this
software.  The most common indication of one of these problems is a
"LOADER NOT READY" or similar message on the unit, sometimes
intermittently displayed.

If you encounter a problem that cannot easily be solved, contact
Technical Support as described below.

======================================================================
==     Technical Support
======================================================================

Technical support for either the GPS Database Loader program or 



NETLOAD.EXE is available from Bendix/King via voice, fax, and E-mail
as described below:

        Monday through Friday between 8 A.M. and 5 P.M., Central Time 
        Voice:      (800) 257-0726 (U.S. Callers)
                    (913) 712-0600 (International)

        The following fax machine is available 24 hours a day.
        Attention the fax to "GPS Database Loader Technical Support"
        Fax:        (913) 712-1306

        E-mail:   nav.database@honeywell.com

        web site:   www.gpsdatabase.com

Bendix/King Customer Service & GPS Database Loader Technical Support:

Please have the following information ready before contacting 
us for assistance:

(1)     The FULL error message (if any) that you encountered.
        Please write down the message exactly as it appears.

(2)     The GPS Database Loader version number.  This may be
        found in the About window which appears when you click
        on the "About GPS Database Loader" option on the GPS
        Database Loader's Help Menu.

(3)     The personal computer type, manufacturer, and model you
        are using.  Is it a desktop or a laptop computer?

(4)     The version of Microsoft Windows (or MS-DOS) you are using.

(5)     The type of Bendix/King GPS unit that you have.

(6)     The Operational Revision Status (ORS) number on the
        GPS unit's Turn-On page.

(7)     The GPS unit host software version number (see table below).

        GPS Unit Type           Location of Software Version Number
        -------------------     -----------------------------------
        KLN 90/A/B, KLN 900     STA 3 page
        KLN 89/B                OTH 6 page
        KLN 35A                 OTH 5 page
        KLN 94                  AUX 14 page

(8)     Any other pertinent information.

Whenever you contact us, please remember to include your full 
name, phone number, fax number, company name, street address, 
city, country, and E-mail address.

======================================================================
==     Database Subscriptions
======================================================================
Database Subscriptions can be purchased from Bendix/King Navigation
Services as follows:

        Monday thru Friday, between 8 A.M. and 5 P.M., Central Time
        Voice:      (800) 247-0230 (U.S. Callers)
                    (913) 712-3145 (International)

        The following fax machine is available 24 hours a day.
        Fax:        (913) 712-3904 (Wingman Services)

        Web site:   www.gpsdatabase.com
        E-mail:     nav.database@honeywell.com



======================================================================
==     General Information about Honeywell Products and Services
======================================================================

General Information about Honeywell Products and Services can
be obtained as follows:

        Monday thru Friday, between 8 A.M. and 5 P.M., Central Time
        Voice:      (800) 347-5462 (U.S. Callers)
                    (913) 712-0400 (International)

        The following fax machines are available 24 hours a day.
        Attention the fax to "General Product Information".
        Fax:        (913) 712-1301 (General Information)
                    (913) 712-1335 (Domestic Orders)
                    (913) 712-1302 (International Orders)

        web site:   www.bendixking.com

======================================================================
==     You may write us at the following address
======================================================================
If desired, you may also write us at the following address:

        Honeywell International Inc.
        Wingman Services, Mail Drop #66
        23500 West 105th Street
        Olathe, Kansas 66061
        U.S.A.

Whenever you contact us, please remember to include your full name,
phone number, fax number, company name, street address, city,
country, and E-mail address.

======================================================================
==     Database Key
======================================================================

A database "key" is an 8-digit hexadecimal number that uniquely 
associates a single database file to a single GPS unit.

Every unit has its own unique database key.  In the case of KLN 90's 
and KLN 89's where they have removable data cards, the unique database 
key travels with the cartridge, and does not stay with the unit.

Several units have had their software modified so that they will 
display the database key on their database update page as follows:

        Unit          Page where key is displayed
        KLN 900       SET 0 page
        KLN 90        (not displayed)
        KLN 90A       (not displayed)
        KLN 90B       SET 0 page
        KLN 89/B      SET 3 page
        KLN 94        SET 3 page
        KLN 35A       (not displayed)
        KLX 135A      (not displayed)
        KLX 100 I/O SETUP -> UPDATE DATABASE

If your key is not visible, then you will need to use either the
KEYCHECK.EXE program or the GPS Database Loader to read the key
from your GPS unit.

To download the KEYCHECK.EXE program from the www.gpsdatabase.com
web site, select "Download", select "DB Key", select "Database Key"
and then select "Key Reader Utility", and following the provided
instructions.

Perform the following steps to use the Windows-based GPS Database
Loader to determine the database key for a Bendix/King GPS unit 
which does not display the key on its database update page:



1.      Connect your Bendix/King GPS Unit to the COM Port of your 
        PC using the appropriate interface cable.
2.      From the Tools menu, select "Read Database Key from -> 
        a GPS Unit".
3.      Select your GPS unit type and desired COM port from the 
        displayed dialog box.
4.      Power-ON the GPS unit.  Press ENT as required to approve 
        the various initialization pages.  Then, go to the 
        database update page (SET 0 or SET 3).
5.      Press the CRSR button.  UPDATE PUBLISHED DB? will now 
        be flashing (or displayed in inverse video).
6.      After you select your GPS unit type, the GPS Database 
        Loader will ask you to press ENT on the GPS's database 
        update page.
7.      After you press ENT on the GPS unit's database update 
        page, the GPS Database Loader will establish communi-
        cations with the GPS unit and display the database key.

======================================================================
==     Updating the KLN 94 Database Card
======================================================================

The Windows-based GPS Database Loader will allow you to update your 
KLN 94 database card by three separate methods.  
(1) KLN 94 is connected to the PCs COM Port using a Data Loader Cable
(2) Card is inserted into an ImageMate that is attached to the PCs USB port
(3) Card is inserted into the PCs PCMCIA port using a PC Card Adapter

For complete instructions, start the GPS Database Loader 
program by selecting: Start -> Programs -> GPS Database Loader.
Then select "Help" from the menu, then select "Help Topics" 
-> double-click on "Update GPS Unit", and then double-click on
"Update KLN 94 Database Card".

The GPS Database Loader will allow you to update your KLN 94 
database card directly from your PC using either the PC's 
PCMCIA slot or a ImageMate that is attached to the PC's USB port. 
When you are finished updating your KLN 94 Database Card, you 
can simply take the Database Card out to the airplane on the 
tarmac rather than carrying an entire computer out to the airplane.

======================================================================
==     Licensing Statement
======================================================================

The Honeywell GPS databases contain information which is proprietary
to Honeywell International Inc. and Jeppesen-Sanderson, Inc.
A Honeywell GPS database may not be duplicated in part or in whole
for any purpose other than installing the data into a Honeywell GPS
product, except as specifically authorized in writing by Honeywell
International Inc.

A single Honeywell GPS database may be used to update a single
Honeywell unit.  The same Honeywell GPS unit may be updated
with the same Honeywell database as often as desired.  A database
download may not be used to updated more than one Honeywell
GPS unit.  Any attempts to do so will be prosecuted to the fullest
extent of the law.

======================================================================
==     GPS Database Loader Software License Agreement
======================================================================

Important - Please Read Carefully

  This is a legal agreement between the user (either an individual or 
  entity) of the GPS Database Loader and NETLOAD software products 
  (including, but not limited to, the software, GPS databases, 
  documentation, and any copies thereof) and Honeywell International



  Inc.  Use of either the GPS Database Loader software product or the
  associated Honeywell GPS databases indicates your acceptance of the
  terms of this license agreement.

Grant of License

  Honeywell International Inc. grants you the right to use the GPS
  Database Loader software and the associated Honeywell GPS database 
  update files according to the following terms and conditions:

1)      You may download (free of charge) the GPS Database Loader 
        program from the www.gpsdatabase.com web site and install the 
        GPS Database Loader program on your computer using the provided 
        SETUP.EXE program.

2)      You may use the GPS Database Loader program to update the 
        navigation database in your KLN 90/A/B, KLN 900, KLN 89/B, 
        KLX 135A, KLN 35A, KLX 100, or KLN 94 Bendix/King GPS unit 
        with database updates that you have purchased from Honeywell 
        and downloaded from the www.gpsdatabase.com web site to your 
        computer.

3)      A single Honeywell GPS database may be used to update a 
        single Honeywell GPS unit.  The same Honeywell GPS unit 
        may be updated with the same Honeywell database as often 
        as desired.  A database download may not be used to update 
        more than one Honeywell GPS unit.  Any attempts to do so 
        will be prosecuted to the fullest extent of the law.

4)      The Honeywell GPS databases contain information which is 
        proprietary to Honeywell International Inc. and Jeppesen-
        Sanderson Inc.  A Honeywell GPS database may not be 
        duplicated in part or in whole for any purpose other than 
        installing the data into a Honeywell GPS product, except 
        as specifically authorized in writing by Honeywell 
        International Inc.

5)      You may print out any associated documentation for use 
        with the GPS Database Loader software program.

6)      Without the express written approval of Honeywell 
        International Inc., you may not use the software in a 
        computer service business.  This includes rental, networking, 
        and timesharing applications.

7)      You may not copy, modify, or transfer, electronically or 
        otherwise, the GPS Database Loader software or copies of 
        the software, except as provided above.

8)      You may not copy, modify, or transfer, electronically or 
        otherwise, a Honeywell GPS database or copies of a 
        Honeywell GPS database, except as provided above.

9)      You may not reverse engineer, decompile, or disassemble 
        the GPS Database Loader software product or any GPS database 
        file.

Term of License

This license agreement is effective from the date that the GPS 
Database Loader program or any GPS database is downloaded from 
the www.gpsdatabase.com web site and shall remain in force 
until terminated.  You may terminate the license at any time 
upon one (1) month's prior written notice.  Honeywell 
International Inc. may terminate this agreement if you fail 
to comply with any of the terms or conditions of it stated herein.  
Upon any termination of this license, you must destroy the licensed 
software, all GPS database files, documentation, and any copies 
thereof in any form.

Copyright

The software product (including any images, photographs, 



animations, and text incorporated into the software and/or 
documentation) is owned by Honeywell International Inc. and 
is protected by United States copyright laws and international 
treaty provisions.  The software product is to be treated as 
any other copyrighted material except that you may make one 
(1) copy of the original software program for backup purposes.

Limitation of Liability

Under no circumstances, shall Honeywell International Inc. be 
liable for any incidental, indirect, special, or consequential 
damages that result from the use or inability to use the software 
or related documentation, even if Honeywell International Inc. 
or a Honeywell International Inc. representative has been advised 
of the possibility of such damages.  Some jurisdictions do not 
allow the limitation or exclusion of liability for incidental 
or consequential damages, so the above limitation may not apply 
to you.

In no event shall Honeywell International Inc.'s total liability 
to you for all damages, losses, and causes of actions exceed 
the amount paid by you for the software.  In no event shall 
Honeywell International Inc. be liable to you or a third party 
for any incidental, special, indirect, or consequential damages 
that may incur as a result of using the licensed software.  This 
includes, but is not limited to, any loss of data or information 
of any kind that you may experience.

For Further Information

For questions concerning the licensing agreement with Honeywell 
International Inc., contact Honeywell at 800-247-0230 or 913-712-3145.

HONEYWELL INTERNATIONAL INC.
One Technology Center
23500 West 105th Street
Olathe, Kansas 66061
U.S.A.
Phone:  (913) 782-0400

Copyright (c) 2001 by Honeywell International Inc.  All rights reserved.

Bendix/King and the Bendix/King logo are registered trademarks 
of Honeywell International Inc., U.S. Patent & Trademark Office.
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Microsoft, Windows, Windows 95, Windows 98, Windows 2000, Windows XP,
Windows Millennium edition, Windows for Workgroups and Windows NT 
are trademarks or registered trademarks of Microsoft Corporation.


